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|.About Career Futures

Give middle school students the tools they need to explore careers and
build meaningful high school plans. Career Futures software guides
students through engaging self-awareness activities, helping them make
informed choices about high school.

I-1 Getting Started
This documentation contains instructions for Windows and Macintosh
versions of Career Futures.

-2 Optional Add-ons for Career Futures

1-2-1 State and Region-Specific Data

During the installation of Career Futures you will be prompted to install
the National or National and State Specific data for Career Futures. At the
time of production, available state or regional information will be included
on the National CD-ROM and the remaining state information will be

located at:
U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/

Click Product Updates under the Support section.

In some areas, you may also be mailed state or regional information to add
to the National database.

1-2-2 Screen Reader Support

Career Futures supports third-party screen reader applications (such as
JAWS) for the visually impaired. When installing Career Futures, at the
Select Program Folder screen you will notice a checkbox option to “Include
shortcuts to Career Futures for screen readers.” If you wish to include
shortcuts to Career Futures for screen readers, please select this option. If
you have JAWS installed, after copying the Career Futures files the installer
will ask if you would like to install the JAWS script files. These script files
are designed to aid the JAWS program in interpreting the Career Futures
program. If you choose to install these files, you will be asked to locate the
folder in which JAWS is installed.

1-2-3 Career Aptitude Survey (CAS) (Optional)

The Career Aptitude Survey (CAS) is an optional resource. The CAS multi-
aptitude test battery gives individuals a snapshot of their potential for
specific occupations. The CAS is fully integrated with Career Futures, and
may only be accessed within the Career Futures program.

The CAS password is located in the Career Aptitude Survey (CAS)
Installation Guide if purchased.

Please note that you should have your CAS password on hand, as you will
be prompted to enter it. The CAS Administration Guide is also located
online and accessible from the Career Futures Options screen.
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1-2-4 Other Products
For more information about Bridges suite of products, please visit:
u.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Products on the front page.

2.Windows and Macintosh Overview
2-1 Before You Begin

Before you begin installing Career Futures 2004, consider the following
information.

2-1-1 View Online Technical and Browser Requirements
For information on technical and Internet browser requirements, please
view our online technical support site.

View the Tech Support pages on our Web site for technical and browser
requirements:

U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Tech Support under the Support section.

2-1-2 Check 16-Bit Application Compatibility (Windows only)
Please ensure you are able to run 16-bit applications and that no policies
prevent 16-bit applications from running.

2-1-3 Backing Up Data Before Installing Career Futures 2004

If you are installing Career Futures 2004 over a previous version, please
back up your data. For further information please see Section 2-2 of this
installation manual.

2-1-4 Windows and Macintosh File Format - Interchanging

Windows and Macintosh session files are created in different formats and
cannot be mixed.

2-1-5 Install on a Network Server or Standalone Workstation?
Decide if you want to install Career Futures on a network server or a
workstation (standalone). It is strongly recommended that you install
Career Futures on a server, and have all clients run Career Futures from
that server.

If you can answer yes to any of the questions below, please complete a
Server installation of Career Futures:

3 Do you want to back up Session Files from one central location?
3 Do you have multiple computers?

O Do you want to apply software updates to one central location?
3 Do you want to customize items in Career Futures for all users?
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If you answered yes to any of these questions, please complete a Server
installation of Career Futures. See Section 3 of this manual for information
about different Windows network types, or Section 13 for Macintosh
network types. Some preliminary steps must be taken to prepare your server
for Career Futures installation.

If you have any installation issues, please check our Web site's Tech Support
pages for FAQs and troubleshooting tips.

U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Tech Support under the Support section.
2-1-6 After Installing Career Futures
Access any available software updates via Career Futures. Open the System
Manager and select the Software Updates button. This will take you directly
to the Bridges.com Web site where you can select the appropriate updates.
2-1-7 Resources Available Through Bridges.com
Many additional resources are available from the Bridges.com Web site:
U.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Support on our Web site’s front page.

The Tech Support link provides information for application tips, tech
answers by product, Web browsers, and technical requirements.

Select Training Options for information about no-charge telephone
training, on-site and regional training options.

Select Teaching Tools for resource materials, such as user guides, access
reference cards for students, parents and educators, and lesson plans.

2-1-8 Passwords — Session File Passwords are Optional

When installing Career Futures, you will be given the option to disable the
Session File Password feature. By default, Career Futures session files will
require passwords to be set up when creating a new session, however you
may turn this option on or off at any time. If you do not want new sessions
to be password protected, complete the following steps.

e From the Career Futures Start screen (Options) click File, then select
System Manager.

» Enter the System Manager password (See Insert for more information).
 Select Setup Options.
* Uncheck the box that says ‘Files require password.’

Note: Disabling this option will not remove password protection from
session files that already have passwords.

2-1-9 System Manager Password
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System Manager access requires a password. See Section 7-2 for more
information.

2-1-10 Change the Location of the Saved Sessions files.

After you have installed Career Futures and before you begin creating
Sessions, you can decide where you would like the Session files
saved.Complete the following steps:

e From the Career Futures Start screen click File, then select System
Manager.

e Enter the System Manager password.
 Select Setup Options.

= In the section ‘Choose directory for Career Futures files’ click Browse and
chose the directory in which you would like the Sessions files to reside.

Note: to use Career Futures, users will need read and write access to this
folder.

2-2 Before Installing Career Futures

Before you begin installing Career Futures 2004, please read the Installation
Guide and visit our Web site for the latest resource materials.

u.S. http://www.bridges.com/

Canada http://www.bridges.com/canada/
Click Teaching Tools under the Support section. Click Resources Materials
for Your Product then click Career Futures in the Middle Schools product
list.

It is important that your network supervisor or administrator assist you with
installing and configuring Career Futures. If you have any questions, please
see your technician or contact our Customer Support team at 1-800-281-
1168, or by e-mail at tech-support@bridges.com.

2-2-1 Important Data Transfer Information

Please BACK-UP ANY SAVED SESSION FILES (located by default in the
SESSIONS subfolder of the folder in which Career Futures 2003 resides)
before starting to install Career Futures 2004.

If you have customized Career Futures, please print these changes and
BACK UP the ENTIRE CAREER FUTURES Folder. This provides access to
your saved information should any problems arise during the installation of
Career Futures 2004 and the migration of data from Career Futures 2003.
If you have any questions regarding this process, please contact our
Customer Support team at 1-800-281-1168.

Career Futures 2003 allowed you to make modifications to the
occupations, local resources, Extras, Career Pathways HTML files and
letters. This information from Career Futures 2003 will be retained but
only if you install Career Futures 2004 into the same folder as your Career
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Futures 2003. You will be prompted to retain Career Futures 2003
customization and user session files (for Windows version only).

Before you begin your installation also have the following information
available:

e The drive on which you want the program installed.

< The name of the directory or folder in which you want the program
installed.

e The components of Career Futures you wish to install.

2-2-2 Select an Installation Type
For MAC installations, please go to section 11-1 Macintosh.

For a Windows installation please select one of the following:

« For a Network Installation please see Section 3 for Windows Network
Preparation.

« For a Workstation Installation please see Section 5 for a Workstation
Installation.

3. Network Preparation - Windows

There are various ways to install and run Career Futures 2004 from
Windows Clients to a Windows File Server. Below are suggestions for the
most common combinations — intended as a guide only.

Career Futures for Windows is installed using the InstallShield program
found on the Career Futures Installation CD. This program installs Career
Futures to the necessary folders on your hard drive and copies the files from
the Career Futures CD-ROM to these folders. Please read the “Before you
begin”, notice in section 2-1, to assist you with the following selections.
Before proceeding with installing Career Futures, ensure you are logged
into Windows with an Administrator account.

3-1 Windows 2000 Server

3-1-1 Creating a Shared folder for the Installation
Creating Shared Install folder on Server

* On the server create a “Career Futures” folder.

 Right-click the “Career Futures” folder and select Properties. Select the
Sharing tab.

» Click Share this folder, then click Permissions.

By default the Everyone group has Full control. Only users that have
accounts created on the server can access via the Everyone group.

3-1-2 Assigning File/Folder Permissions to the Shared Install
Folder

= Open Windows Explorer and right-click the Career Futures folder. Click
Properties. Select the Security tab. By default Everyone group has Full

6 access.
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< Uncheck Allow inheritable permissions from parent to propagate to this
object. Click Remove in the security warning box.

 Click Add and select the Administrators group. Click OK.
e Check Full Control access.
 Click Add and add the “Low Level Access User Group.”

e Check “Read & Execute” access for the “Low Level Access User Group.”
The other two will auto-select. Click OK.

3-1-3 Create Mapping (On Windows Clients)

Career Futures and the installer program do not support the Universal
Naming Convention (UNC). Therefore, you need to use a drive letter to run
Career Futures or the installer. See Section 4-2 Mapping to Network Drive.

NOW INSTALL THE CAREER FUTURES 2004 PRODUCT TO THE SHARE.
This can be done from a client through the mapped drive to a server using
the “Server” install method, or locally at the server. Once installed, the
remaining client workstations can have a shortcut created on their desktop.

Note: If the client is Windows XP please refer to section 4-1. You must
install to the server from the XP client using the “Server” method as detailed
section 4-1.

3-1-4 Giving Full Access to the Sessions Folder.
« Right-click the Sessions folder and select the Security tab.

 Select “Low Level Access User Group” and check Full access.

3-2 Windows NT4 Server

3-2-1 Creating a Shared Folder for the Installation
= On the server create a “Career Futures” folder.

= Right-click the “Career Futures” folder and select Properties. Select the
Sharing tab.

= Select Shared As: then click Permissions.

By default the Everyone group has Full control. Everyone group is only
users that have accounts created on the server.

3-2-2 Assigning File/Folder Permissions to the Shared Install
Folder

< Within Windows Explorer right-click the “Career Futures” folder and
click Properties. Once open, click the Security tab. By default, the
Everyone group has Full access. Click Permissions.

< Remove the Default Everyone group.
< Uncheck the Replace Permissions on Subdirectories.
 Click Add and select the Administrators group. Click OK.
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e Check Full Control access.
e Now click Add and add the “Low Level Access User Group.”

e Check Read access for the “Low Level Access User Group.” Click Yes to
“Warning, as this will affect all subdirectories.”

* Click OK.

3-2-3 Create Mapping (On Windows Clients)

Career Futures and the installer program do not support the Universal
Naming Convention (UNC). Therefore, you need to use a drive letter in
order to run Career Futures or the installer. See Section 4-2 Mapping to
Network Drive.

NOW INSTALL THE CAREER FUTURES 2004 PRODUCT TO THE SHARE.

This can be done from a client through the mapped drive to a server using

the “Server” install method, or locally at the server. Once installed, the

remaining client workstations can have a shortcut created on their desktop.
3-2-4 Giving Full Access to the Sessions Folder.

< Right click the Sessions folder and select the Security tab.

 Select “Low Level Access User Group” and select Permissions. Select Full
Control access from the Type of Access pulldown list. Click OK to finish.

3-3 Novell Networks
Note: Ensure the Novell client is at least: 4.83(SP1) for Windows
NT/2000/XP and 3.32(SP1) for Windows 95/98/ME.
3-3-1 Creating a Shared folder for the Installation
On the server create a “Career Futures” folder.

3-3-2 Assigning File/Folder Permissions to the Shared Install
Folder
 Right-click the “Career Futures” folder and select Properties. Select the
NetWare Rights tab.

e Check Read and Execute rights for the “Low Level Access User Group.”

3-3-3 Create Mapping (On Windows Clients)
Career Futures and the installer program do not support the Universal
Naming Convention (UNC). Therefore, you need to use a drive letter in
order to run Career Futures or the installer. See Section 4-2 Mapping to
Network Drive

NOW INSTALL THE CAREER FUTURES 2004 PRODUCT TO THE SHARE.
This can be done from a client through the mapped drive to a server using
the “Server” install method. Once installed, the remaining client
workstations can have a shortcut created on their desktop.
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3-4 Post Installation of Career Futures

3-4-1 Giving Full Access to the Sessions Folder
(Windows Based)
« Right-click the Sessions folder and select the Security tab.

« Select “Low Level Access User Group” and select Permissions. Check Full
Control access from the Type of Access pulldown list. Click OK to finish.

3-4-2 Giving Full Access to the Session Folder (Novell Based)

< From the Novell Client workstation, right-click the Sessions folder and
select the Netware Rights tab.

e For NetWare 3.xx and higher, select “Low Level Access User Group” and
give full rights [R,W, C, E, M, F] (Read, Write, Create, Erase, Modify, File
Scan).
4. Running Career Futures 2004 - Windows
4-1 Windows XP Professional Clients Connecting to
Windows-Based Servers

On the Windows XP Client, log in as Administrator with the same login
credentials as the Windows Server Administrator account. The following
steps are only required the first time Career Futures 2004 is installed onto
the server. Once installed, all remaining Windows XP clients can have a
shortcut created on their desktop as described below.

4-2 Mapping to Network Drive
e Double-click My Computer.
« Select Map Network Drive from the Tools menu.

« Click Browse to locate the server’s shared Career Futures folder. Click
Finish. The network drive you have mapped should be visible in the My
Computer list.

4-3 Windows 98 Clients and Windows Server

This assumes Career Futures 2004 has already been installed on a server
and the folders have been installed and permissions set while logged on as a
member of the “Low Level Access User Group.”

To create a shortcut on the workstation desktop:
e Double-click the Network Neighborhood icon on your desktop.

e Locate the Network server, which contains the shared Career Futures
folder. Right-click the shared folder and select Map Network Drive.

 Select Reconnect at logon and click OK.

The network drive you have mapped should be visible in the My Computer
list.
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e Open Windows Explorer, open the mapped drive and navigate to the
Wiutures.exe file inside the \Career Futures\Apps folder.

 Right-click Wfutures.exe and choose Desktop from the Send To list. A
shortcut will be created on the desktop. Rename shortcut to Career
Futures.

e Click Next. Change the desktop shortcut name from Wfutures to Career
Futures 2004. Click Finish.

4-4 Windows 2000 Professional Clients and Windows
Server

This assumes the Career Futures 2004 has already been installed on a
server and the folders have been installed and permissions set while logged
on as a member of the “Low Level Access User Group.”

To create a shortcut on the workstation desktop:

e Open My Computer and open Tools. Click Map Network Drive. Select
Browse.

< Navigate to the shared installation folder on the Windows Server. Click
Finish.

e Open My Computer, right-click the local hard drive (C:) and choose
Explore.

e Under “Documents and Settings” choose the User account (a member of
the “Low Level Access User Group”) and then the desktop folder. Note:
you can install the Career Futures 2004 Shortcut on every user’s desktop
by creating the shortcut in the “All Users” desktop folder.

< Now right-click the right-hand pane and select Shortcut from the New
menu.

« Click Browse, then navigate to the mapped drive and find the
Wiutures.exe file in the \Career Futures\Apps folder. Click OK.

 Click Next. Change the desktop shortcut name from Wfutures to Career
Futures 2004. Click Finish.
4-5 Windows Clients Connecting Novell Netware -
Based Servers

Note: Ensure the Novell client is at least 4.83(SP1) for Windows
NT/2000/XP or 3.32(SP1) for Windows 95/98/ME.

For a Windows XP Client, log in as Administrator with same login
credentials as the Netware Server Administrator account.

4-5-1 Mapping to Network Drive
e Double-click My Network Places, then double-click Novell Connections.
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« Double-click the server icon, double-click the volume on which the
Career Futures folder resides.

« Right-click the Career Futures folder and then click Novell Map Network
Drive...

« Select the drive letter. Ensure that “Make folder appear as the top-most
level” and “Always map the drive letter when you start windows” are
checked.

The network drive you have mapped should be visible in the My Computer
list.

4-5-2 Creating a Shortcut on the Workstation Desktop.

* Open My Computer. Right-click the local hard drive (C:) and choose
Explore.

e Under “Documents and Settings” choose the User account (a member of
the “Low Level Access User Group”) and then the desktop folder. Note:
you can install the Career Futures 2004 shortcut on every user’s desktop
by creating the shortcut in the “All Users” desktop folder.

< Now right-click the right-hand pane and select Shortcut from the New
menu.

 Click Browse and navigate to the mapped drive and find the Wfutures.exe
file in the \Career Futures\Apps folder. Click OK.

 Click Next. Change the desktop shortcut name from Wfutures to Career
Futures 2004. Click Finish.

4-5-3 Windows 98 Clients and Netware Server
To create a shortcut on the workstation desktop:

e Double-click the Network Neighborhood on your desktop.

* Find the Network server on which the Career Futures 2004 software is
installed. Double-click to show shared folders available on the server.

« Right-click the shared Career Futures folder and select Map Network
Drive.

 Select Reconnect at logon and click OK.

< The network drive you have mapped should be visible in the My
Computer list.

« Open Windows Explorer, open the mapped drive and navigate to the
Wiutures.exe file inside the \Career Futures\Apps folder.

 Right-click Wfutures.exe and choose Desktop from the Send To list. A
shortcut will be created on the desktop.

e Click Next. Change the desktop shortcut name from Wfutures to Career
Futures 2004. Click Finish.
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4-5-4 Windows 2000 Professional Clients and Netware Server
To create a shortcut on the workstation desktop:

e Open My Computer, select Tools and click Map Network Drive. Select
Browse.

< Navigate to the shared installation folder on the Windows server. Click
Finish.

e Open My Computer, right-click the local hard drive (C:) and choose
Explore.

e Under “Documents and Settings” choose the User account (a member of
the “Low Level Access User Group”) and then the desktop folder. Note:
you can install the Career Futures 2004 shortcut on every user’s desktop
by creating the shortcut in the “All Users” desktop folder.

 Right-click the right-hand pane and select Shortcut from the New menu.

« Click Browse, then navigate to the mapped drive and find the
Wiutures.exe file in the \Career Futures\Apps folder. Click OK.

 Click Next. Change the desktop shortcut name from Wfutures to Career
Futures 2004. Click Finish.

5.Workstation (Stand-Alone) or Server

(Network) Installation

To complete a Workstation (Stand-Alone) or Server (Network) Installation, it
is important that your network supervisor or administrator assist you with
installing and configuring Career Futures. If you have any questions, please
see your technician or contact our Customer Support team at 1-800-281-
1168, or by e-mail at tech-support@bridges.com. Please ensure you have
read Section 2-1 “Before you Begin”.

5-1 To Install Career Futures from the CD-ROM

12

Insert the Career Futures 2004 Installation CD into your CD-ROM drive. If
the installer does not start automatically, then proceed with the following
instructions:

e Choose Run from the Start menu.

» Type x:\setup where “X” is the letter that corresponds to your CD-ROM
drive. Click OK.

» Click Next on the Career Futures 2004 splash screen.

< The Bridges.com licensing agreement will appear. You can choose | Accept
or 1 Do Not Accept. However, to continue with the installation, you must
click I Accept.

< Enter the name of your school, organization or agency. This is the title,
which will be displayed on all report headings. Click OK.
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< You will be prompted to select whether you will be installing Career
Futures to a Workstation or a Server. If you are installing to a workstation,
the Career Futures 2004 Program Group and icons will automatically be
created. If you are installing Career Futures to a server, please refer to
section 4 for how to create a shortcut on the workstation desktop. Click
Next. Follow the instructions on your screen. Be sure to select all the
possible components.

« Follow the instructions on your screen.

5-2 Career Videos Installation

Career videos, previously a CD-ROM-based option for Career Futures, are
now provided on the Web at no additional cost. Links to these online video
clips will automatically be installed as part of your Career Futures software.

5-3 Career Aptitude Survey (CAS) Installation

(Optional)
The Career Aptitude Survey (CAS) is an optional assessment, which can be
added to Career Futures (if it has been purchased).

To add the CAS as an assessment in Career Futures, please select the
Career Aptitude Survey when prompted during the Career Futures
installation process. Refer to the Career Aptitude Survey (CAS) Installation
Guide for the password and enter the password for the CAS when
prompted.

6. Removing Career Futures
6-1 Removal of Career Futures 2003

Prior to removal, please make a back-up copy of any saved sessions you
wish to keep (located by default in the SESSIONS subfolder of the folder
where Career Futures 2003 resides) as well as any customized pages or
modifications to occupations, local resources, Extras and Career Pathways
HTML files and letters, you have created. This provides access to your saved
information should any problems arise during the installation of Career
Futures 2003 and the migration of data from Career Futures 2004.

Career Futures 2003 can be removed by installing Career Futures 2004
into the same folder where Career Futures 2003 is installed. This will
overwrite your Career Futures 2003.

OR

1. Using Windows Explorer, locate the Career Futures folder on the drive
on which it has been installed.

2. Select the Career Futures folder.

3. Choose Delete from the File menu.
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6-2 Removal of Career Futures 2004

Prior to removal, please make a back-up copy of any saved sessions you
wish to keep (located by default in the SESSIONS subfolder of the folder
where Career Futures 2004 resides) as well as any customized pages or
modifications to occupations, local resources, Extras and Career Pathways
HTML files and letters, which you have created. This provides access to
your saved information should any problems arise.

1. Using Windows Explorer, locate the Career Futures folder on the drive
on which it has been installed.

2. Select the Career Futures folder.

3. Choose Delete from the File menu.

7. System Manager (Career Futures
Administration) - Windows

7-1 About the System Manager
The System Manager contains resources to customize Career Futures.

7-2 The System Manager Requires a Password

The System Manager requires a password.

If the password has been changed please call Customer Support at 1-800-
281-1168, or e-mail tech-support@bridges.com for steps on how to override
this password.

7-3 System Manager Change Setup Options - Windows
7-3-1 Change System Manager Password
Allows you to change the password for the system manager.

7-3-2 Session Files Master Password
Allows you to change the master password for the session files.

7-3-3 Setup Options
Use Setup Options to change the default directory for the session files;
change or enter a Site Name; and add or remove password protection of
session files.

7-3-4 Time Service Server
Time Service Server allows you to select the server running the time service
to get the current date.

7-3-5 Search Topics and Options

Choose the search topics available on the Occupation Search Topics list in
the Career Futures database. Allow entry of the ASVAB scores and enable
database searching.
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7-3-6 Report Topics
Choose topics to be displayed on the Career Futures reports. Choose
Enable this list of report topics to use this list in Career Futures.

7-3-7 Create Sample Letters
Allows you to create or edit the sample letters that users can personalize or
print in Career Futures.

7-3-8 Edit Local Information
Allows you to create or edit local information associated with items in the
Career Futures databases, including the Local Resources database.

7-3-9 Edit Course Plans
Allows you to change the four-year course plans shown in the Career
Futures occupations reports.

7-3-10 Extras! Pages
Allows you to change the Extras Pages for the occupations databases.

7-3-11 Software Updates

Allows you to browse available software downloads for Career Futures on
the Bridges.com Web site. To access this information directly go to:

U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Product Updates under Support on our Web site’s front page.

7-4 Other Customizations
7-4-1 Report Topic Information

Report Topic Information can be customized. Information for Suggested
High School Subjects is available in the occupation reports. If these features
are not active in your version of Career Futures 2004 and you would like to
activate them, go to the System Manager (you will be prompted for the
password) and select Report Topics. Scroll down the list and select the
option(s) you require, then click OK.

7-4-2 Professional Manual

The Professional Manual explains the rationale, theory, and philosophy
behind Career Futures' development; provides an explanation of the topics
and factors available and tips for their effective use; and provides access
strategies for using and implementing Career Futures. To access the
Professional Manual: on the Career Futures Options screen click Resource
Materials and select Professional Manual.
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7-5 Web Browser

7-5-1 Changing your Internet Browser /| Modifying Internet
Access*

During the installation process, you were prompted to choose one of three
Web browsers: the Career Futures built-in Web browser, Netscape
Navigator, or Internet Explorer. It is recommended that you use Netscape
Navigator or Internet Explorer to ensure compatibility with Web pages.

The following instructions will overwrite the setup for all users running
Career Futures from the network, except for those who have changed the
setup using the Select Web browser feature below. It is possible to reverse
the original decision in one of two ways:

1. Locate the Career Futures folder on the drive on which it has been
installed.

2. Open the Common\config.ini file.

3. In the file, locate the Web browser Information section.

4. Edit WebBrowser= line using either O for the Career Futures built-in Web

browser, 1 for Internet Explorer, or 2 for Netscape Navigator.

5. Choose Save from the File menu.

OR

Note: The following instructions will overwrite the setup for the current
workstation.

1. Choose File from the Career Futures menubar.

2. Choose Select Web browser.

3. Enter your System Manager password.

4. Select the Web browser you wish to use.

5. Click OK.

* For more information on our Internet features, please contact our
Customer Support team at 1-800-281-1168 or by e-mail at tech-
support@bridges.com.

8. Printable Resource Materials

For printable support and resource materials to help you use Career Futures
please visit our Web site located at:

u.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/

Click Teaching Tools under the Support section. Click Resource Materials
for Your Product then click Career Futures in the Middle Schools product
list.

9. Installing Adobe Acrobat Reader - Windows

To download Adobe Acrobat go to: http://www.adobe.com and click
Support>Downloads>Adobe Reader>Windows.
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10. Running the Career Futures Application -
Windows

10-1 How to Run the Career Futures Application-
Options
e Click the Career Futures shortcut on your desktop.
« Click Start/Programs and select Career Futures.
e Open My Computer and open the Career Futures/Apps folder. Double-
click the Wfutures.exe file.
10-2 Career Futures Session Files

Career Futures Session files will have the extension .CHS added
automatically. By default the Session files will be saved to the Career
Futures/Sessions folder. This path can be changed in the System Manager.
Password protection of the Career Futures Session files can be turned on or
off in the System Manager.

When saving, please remember that file names MUST NOT contain the
following characters: /2\<>;:*#".

I 1. Macintosh
11-1 Before you begin

Please see Sections 1 and 2 for product information and installation
information.

2. Important Data Transfer Information

Please make a back-up copy of any saved sessions (located by default in the
SESSIONS subfolder of the folder where Career Futures 2003 resides)
before starting to install Career Futures 2004.

Please note that research information, modifications to occupations, local
resources, Extras and Career Pathways HTML files and letters entered in
Career Futures 2003 that you may have saved, cannot be transferred. If you
would like to retain this information for use in Career Futures 2004, please
contact our Customer Support team at 1-800-281-1168 for instructions.
Career Futures 2004 will be installed in a different folder than Career
Futures 2003. To avoid possible confusion and to conserve disk space, we
recommend that you remove Career Futures 2003 from your hard drive
after saving any modifications noted in the previous paragraph.

3. Network Installation Notes — Macintosh

You can install and run Career Futures 2004 from Macintosh Clients to
Windows Based Servers in various ways. Below are suggestions for the most
common combinations — intended as a guide only.
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13-1 Installation of Career Futures —

18

Windows Server-Based

13-1-1 Macintosh Clients on Window 2000 Server
Configuring Macintosh Sharing Rights and File/Folder Permissions:

* Log on to the server as an administrator and ensure the Macintosh
Services for Windows have been installed.

* Go to Start. Select Administrative Tools, then select Computer
Management. Double-click Shared Folders, right-click Shares and select
New File Share.

= Browse to the Application folder on your server’s hard drive. Enter the
Share Name (Windows) and the Macintosh Share Name. Check Apple
Macintosh client. Click Next.

 Select either All users have full control for the share or Customize share
and folder permissions depending on the site's security. Click Finish.

e Click No. Another share does not need to be created. Now go to the
Macintosh to see the share.

13-1-2 Macintosh Clients on Window NT4 Server
Configuring Macintosh Sharing Rights and File/Folder Permissions:

e Log on to the server as administrator and ensure the Macintosh Services
for Windows has already been installed.

« Click Start. Select Programs. Select Administrative Tools and select File
Manager.

« Create a folder that will be the Share point for the Macintosh clients.
Select the folder you want to share, then from the File Manager's menubar
select MacFile and then Create Volume.

e The Create Macintosh-Accessible Volume box will appear. Click
Permissions and click the “[...]” box by the Primary group input field to
open the Primary Group list of users. Select the “Low Level Access User
Group” then add the group as the Primary Group. Note: the owner is the
Administrators group. Once the “Low Level Access User Group” has been
selected, click OK.

e Give full “Share” access permissions to the new Primary Group by
checking See Files, See Folders and Make Changes. Click OK. Again click
OK. A warning message may appear, as the volume you are creating may
be greater than 2 GB in size. Click Yes as this problem only affects older
Macintosh Operating Systems.

e Click OK to complete the procedure. The File and Folder permissions for
Windows NT 4 can be configured depending on the site’s security. See
Section 3-2.

* Now go to Macintosh to see the share.
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13-1-3 Running Career Futures From a Macintosh Client
Connected to a Windows Based Server

= Ensure on the Windows Server that a shared folder has been created for
the Macintosh client to connect to.

« Click the Apple icon in the top left corner of the menubar, then select
Network Browser.

* The Windows server will be listed in the Network Browser window.
Double-click this server icon to access the server.

« The server will prompt you for user authentication. Enter the account
name and password that has already been created on the Windows server
and log in.

= Double-click the listed server and the Windows Macintosh Shared folder
created on the server will appear. Note: A Network drive shared folder
now appears on your desktop.

» Double-click the shared folder and the contents will be displayed. At
present, the folder is empty.

e Insert the Career Futures 2004 CD in the CD-ROM drive and the Career
Futures 2004 installer will open. Double-click the Career Futures 2004
installer icon on the desktop to proceed with the installation.

= Once installation is complete, drag the Career Futures 2004 Installer to
the “Trash Can”. This will eject the CD from the CD-ROM drive.

e Double-click the Macintosh HD icon on the desktop.

» Double-click the Career Futures 2004 folder. All these files need to be
copied to the Network shared folder.

* With the Career Futures 2004 folder open, select Edit menu then Select
All. Drag all these files into the open Network shared folder.

= In the Network Server Shared Folder, select the Career Futures
application icon and create an alias by holding down the Option and the
Command key while dragging the icon to the desktop. Rename the alias
icon from Career Futures t0 Career Futures 2004.

e Ensure that Career Futures runs from the Macintosh clients. All the
remaining Macintosh clients can now connect to the Windows Server
Macintosh Share and only an alias needs to be created on each Macintosh
client.

13-1-4 Post Installation -- Server File Access Privileges

When Career Futures is installed on a network, the administrator must
grant to users access privileges for the various folders. The minimum set of
privileges is outlined below. Users may be granted more permission than
they need as long as this minimum set is allowed.

Folder Administrator Needs Users Need

Common See Files See Files
Make Changes

OnTrack See Files See Files
Make Changes Make Changes

*Sessions See Files See Files
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Make Changes Make Changes

*1f you do not want users to save their documents in the Sessions folder,
you can change this option: go to the Career Futures System Manager,
choose Setup Options and change the location of the Sessions folder.

13-1-5 Macintosh Client (Stand-Alone) Installation

1.
2.

3.
. The Bridges.com licensing agreement will now be displayed. You can

9.

Insert the Career Futures 2004 Installation CD into your CD-ROM drive.
A Career Futures icon will appear on your desktop. Double-click the icon.
Double-click the Career Futures 2004 Installer icon.

Click Continue on the Career Futures 2004 splash screen.

choose to either Accept, Decline, or Save the terms of the license
agreement. However, to continue with the installation, you must click
Accept.

. The install “Read Me” notes will be displayed. Please read through all of

the directions. You can also print these notes or save them to a file. Click
Continue to proceed.

. The “Full National-Only” dialog will appear. This will install all of the

core components of Career Futures 2004. Alternately, click on the arrow
and choose Custom Install if you wish to include your state information
or if you would like to remove some of the optional databases that are
installed by default.

. A message will appear: “Following installation, you will be prompted to

supply your site name. Once you have entered this information, Career
Futures will be ready for use.” Click Continue.

. A final message will appear: “Installation was successful. If you are

finished, click Quit to leave the Installer. If you wish to perform
additional installations, click Continue.” Click Quit.
At the Career Futures Registration screen, enter your site name.

13-2 Adding Optional Products
13-2-1 Career Videos Component
Career videos, a suite of video career profiles, is now delivered from the
Web. Links to these videos are installed with Career Futures by default.
13-2-2 Career Aptitude Survey Installation (CAS) (Optional)
See Section 13-1-5, Step 6.

14. Removing Career Futures

14-1 Removal of Career Futures 2004

Please be sure to make a back-up copy of any saved sessions you wish to
keep (located by default in the Sessions subfolder of the folder where you
installed Career Futures 2004). If you would like to keep any customized
pages or modifications to occupations, local resources, Extras and Career
Pathways HTML files, letters, and Planner files which you have created,
please contact our Customer Support team at 1-800-281-1168 for
instructions.

20
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To remove all components:

1. Close the Career Futures 2004 folder.

2. Drag the Career Futures 2004 folder to the trash.

3. Choose Empty Trash from the Special menu.

4. Click OK if the remove dialog box is displayed.

5. Career Futures 2004 has now been removed from your hard disk.

15. System Manager (Career Futures
Administration) - Macintosh
15-1 About System Manager

Many Career Futures 2004 features can be customized to suit your
environment. Please read the detailed explanations of each of the features
listed below.

To launch the System Manager from the Career Futures Start screen
(Options) select Career Futures System Manager from the File menu, or
browse your Macintosh hard drive and open the System Manager folder in
the Career Futures folder. Next select System Manager.

15-2 System Manager requires a password

Accessing the System Manager requires a password. The initial password is
“setup.”-if the password has been changed please call Customer Support at
1-800-281-11687 or e-mail tech-support@bridges.com for steps on how to
override this password.

15-3 System Manager — Change Setup Options
(Macintosh)

15-3-1 Change Setup Options
Allows you to change the System Manager password; change session
password settings; Career Futures preferences, change display, use sessions
folder to save documents, enable Internet browser access, change default
browser, display animation in report pane, display open session dialog at
startup, enable help tips; set session folder location.

15-3-2 Search Topics and Options
Change the Search Topics displayed and enable or disable Search Options,
such as the ASVAB scores in the Occupation Database.

15-3-3 Report Topics
Customize the Occupation Database by choosing which report topics are
displayed in the Occupation information reports.

15-3-4 Create Sample Letters

Allows you to create or edit the sample letters that users can personalize or
print in Career Futures.
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15-3-5 Edit Local Information
Allows you to edit the Local Information in the Occupations Database.

15-3-6 Edit Course Plans

Allows you to change the four-year course plans shown in the Career
Futures occupations reports. This section will edit the text listed in Course
Plans (Career Pathways).

15-3-7 Extra! Pages
Allows you to edit the Extras! Pages in the Occupations Database.

15-3-8 Software Updates

Software Updates allows you to browse available software downloads for
Career Futures on the Bridges.com Web site. To access this information
directly go to:

U.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click Product Updates under Support on our Web site’s front page.

16. Other Resources

16-1 Installing Software Updates

Software Updates allows you to see if any Product Updates are available on
the Bridges.com Web site.

16-2 Bridges-to-Careers Lesson Plans (U.S. Only)

Bridges-to-Careers offers flexible activities that feature career development
concepts and integrate academic and vocational skill building. Grade-level
lessons target self-assessment, career exploration and planning. This year
you can access these activities through Career Futures.

To access the Bridges-to-Careers activities go to the Career Futures start
screen (Options) and select Resource Materials. This will open a section
where you can select and print the activities you would like to use with
your students.

A BTC Reference Guide is also available to help you use Bridges-to-Careers.
The guide shows how lessons align to National Career Development
Guidelines and SCANS (Secretary’s Commission on Achieving Necessary
Skills) and other helpful information. To view the Bridges-to-Careers PDF
files you need Adobe Acrobat Reader installed on your computer. If you do
not have Adobe Acrobat Reader installed on your computer, refer to Section
9 for Windows or Section 17 for Macintosh.

16-3 Printable Resource Materials

For printable support and resource materials to help you use Career
Futures click on Resource Materials from the Options screen or visit our
Web site:
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u.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/

Click Teaching Tools under the Support section. Click Resource Materials
for Your Product then click Career Futures in the Middle Schools product
list.

16-4 Bridges National Training Institute

The Bridges National Training Institute provides a multitude of training
options to suit your needs. We provide no-charge basic training for Bridges'
products, and standards-based curriculum training — comprehensive on-site
workshops to help you achieve your goals using our products.

Join the thousands of educators who increasingly turn to Bridges for all of
their training needs. Visit the following link for pricing, schedules and
registration details:

u.S. http://www.bridges.com/
Canada http://www.bridges.com/canada/
Click on Training Options under the Support section.

17. Installing Adobe Acrobat Reader
(Macintosh)

To download Adobe Acrobat go to: http://www.adobe.com and click
Support>Downloads>Adobe Reader>Macintosh

18. Running the Career Futures Application
(Macintosh)

18-1 How to Run the Career Futures Application-
Options
e Click the Career Futures shortcut on your desktop

e Open the Macintosh Hard Drive and browse the Career Futures folder.
< Open the Apps folder and double-click the Career Futures file.

18-2 Career Futures Session Files

Career Futures Session files will have the extension .CHS added
automatically. By default the Session files will be saved to the Career
Futures/Sessions folder. This path can be changed in the System Manager.
Password protection of the Career Futures Session files can be turned on or
off in the System Manager.

When saving, please remember that file names MUST NOT contain the
following characters: /2\<>;:*#".
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